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7. MODELLAZIONE PARAMETRICA

CREARE FAMIGLIE CON HOST - WORKFLOW

Famiglie di Modello basati su Host
(porte, finestre, maniglie, corpi luminosi)

WORKFLOW

1. Iniziare sempre con uno scheletro definito da Reference Planes.

2. Creare costrizioni dei piani, attraverso parametri e ancoraggi.

3. Testare la famiglia modificando i parametri assegnati e le costrizioni.

4. Disegnare la geometria dell’oggetto e ancorarla a questo scheletro in modo che siano i piani di riferimento a guidare la geometria!!
5. Assegnare Materiali

6. Creare Catalogo di Tipi

7. Salvare e caricare all’'interno del file di progetto.

G +
8 B

Load into Load into
Project |Project and Close

Load into Project

Loads the family into open projects or family files.

(9
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7. MODELLAZIONE PARAMETRICA

CREARE FAMIGLIE CON HOST - APERTURE PARAMETRICHE

Creazione

Nella progettazione architettonica capita spesso di dover modellare delle aperture nei muri, senza serramenti, dei varchi.
Revit permette la modellazione di questo tipo di aperture in due modi:

*  Attraverso la modifica del profilo di un muro esistente

Oppure

*  Attraverso la creazione di una famiglia di aperture parametriche

(9
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7. MODELLAZIONE PARAMETRICA

FAMIGLIA DI APERTURE PARAMETRICHE - TIPOLOGIE

Apertura Rettangolare

Placement Side I

Selezioniamo il template corrispondente i : ‘
. . # " Family Category and Parameters X
Metric Generic Model wall based.rft

Family Category

Filter list: | Architecture v

Casework ~
Columns

A3

Electrical Equipment
Electrical Fixtures
Entourage

Fumiture

Fumiture Systems
Generic Models
Lighting Fixtures

Mass

Mechanical Equipment

| Create |

y| [T M
Family Category and Parameters b
Parameter Value ~

Nelle viste Elevations, selezionare Placement Side Always vertical
Cut with Voids When Loade
Shared

OmniClass Number

Assegnamo al modello una categoria specifica
Create > Family Category and Parameters > Doors

Family Parameters

OO

OmniClass Title v

Disegnare i Reference Plan a cui ancorare la geometria della apertura

(9
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7. MODELLAZIONE PARAMETRICA

FAMIGLIA DI APERTURE PARAMETRICHE - TIPOLOGIE

Disegnamo la geometria e la ancoriamo ai reference planes

Create > Voids

dd-Ins  Site Designer  BI

Removes part of

Dato che si tratta di una estrusione, verifichiamo e allineiamo il void in pianta,

cercando di oltrepassare il muro esistente!

In alternativa possiamo selezionare il muro e utilizzare lo strumento

Create > Openings

=

Opening

-

(@]
Model
Group

NOTA

Opening

Creates an ope

In una famiglia di questo tipo si puo praticare solo una unica apertura!!

/-SAPIENS
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7. MODELLAZIONE PARAMETRICA

Aperture Personalizzate

Sia in caso di volume Void, sia in caso di openings, per creare una
apertura dal profilo irregolare, si puo editare il profilo disegnato (dopo
aver rinominato la famiglia anteriore).

Selezionare il profilo e utilizzare il comando

Modify > Void Extrusion > Edit Estrusion

Edit
Extrusion

{oeis’] Modify | Void Extrusion 1|

l‘g‘l

T
L (E? £ /
Visibility Edit
Settings | Work Plane

,l 7“1 Edit Extrusion

Modify > Opening cut

/-SAPIENS

Tools Modify | Opeﬁing cut

Sketch

mop

=
Load into Load
Project Projecta

| Openin il Edi
Edit Sketch

FAMIGLIA DI APERTURE PARAMETRICHE - TIPOLOGIE

Aperture con Sguincio

Questo tipo di aperture e presente negli edifici storici o
comunque in muratura.

Disegnare i reference planes in pianta e in alzato

3 I
- o || I
| AT
I g 00 1] |
o e ) — — T
' o I
P! % TE - — *—: = i
I_sguincio = 100 > N |
i i, g ‘ ‘
I_porta = 1220 ! < ; ‘
; 1 I
Placement Side wazzetts = 10 ‘
o I I o
i | s
I | &
1_void = 1000 s ‘
¢ ‘ n
1 I | k]
,,,,,,,,, q — k=]
J 4 ‘ \ g
| o | | _::l
EQ EQ ) ! ‘ |
EQ EQ )| I I
- ¥ :
EQ EQ | ‘ |
I |
| I
| [
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7. MODELLAZIONE PARAMETRICA

FAMIGLIA DI APERTURE PARAMETRICHE - TIPOLOGIE

Parametrizzare lo scheletro In alzato (placement side) disegnare lo squincio intorno alla

apertura (un solido VOID), ancorando la geometria all'

L = Limle 1D VIEWS Lalll

— = interasse del muro e al piano esterno del muro.
Type name: }Typel V‘ 'bl_hl [ (|

‘Search parameters Q|

| Parameter Value Formula |Lock| 1

h_porta 2100.0 = h_void + h_sguincio O
h_sguincio 100.0 = O
h_void 2000.0 = O
I_porta (report) 1220.0 =

|_sguincio 100.0 = O
I_sguincio_vert 1540.0 = O
I_void 1000.0 = O
mazzetta 100 = O

Z B o®H tE 3 4t | Manage Lookup Tables
How do I manage family types? I OK H Cancel :‘ e
(9
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7. MODELLAZIONE PARAMETRICA

FAMIGLIA DI APERTURE PARAMETRICHE - TIPOLOGIE

I
Aperture ad ARCO
Per le aperture ad arco, prima di procedere con il disegno, € necessario Selezionare l'opzione a seguire, per visualizzare il centro
attivare la visualizzazione delle qupote automatiche. dell'arco.
<Sketch> (1) v‘ Il:"E“ Edit Type
View > Visibility / Graphics > e 5
. . . . . Center Mark Visible H
> Annotation Categories > Automatic Sketch Dimension Dimensions A
Length 1188.30
T B Il centro sara quindi allineato e ancorato agli assi vert. E oriz.
G Che passano per il centro.
y| ||Visibility/| Thin || Default Camera Sec
Graphics | Lin 3D
- Visibility/ Graphics (VG)
Controls the visibility and graphic
Visibility/Graphic Overrides for Elevation: Placement Side
Model Categories Annotation Categories Imported Categories
Show annotation categories in this view If a categor +

Visibility

=] Dimensions

-1 | Automatic Sketch Dimensions
Levels
Reference Lines
Reference Planes

Create or removealr

L
K| K] &I

/-SAPIENS
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Per la creazione di finestre e porte, possiamo utilizzare il
template predefinito Metric Door.rft oppure Metric

7. MODELLAZIONE PARAMETRICA

Window.rft.

Altrimenti possiamo crearla da zero utilizzando il template

Metric Generic Model wall based.rft

L'unica differenza tra | due tipi di templates & che il
predefinito gia include |'apertura nel muro.

A seqguire, | passi fondamentali per creare una finestra
parametrica formata da un numero di infissi compreso tra

2°en

/-SAPIENS

, attraverso l'utilizzo delle Nested Families.

FAMIGLIA DI FINESTRA PARAMETRICA

WORKFLOW
1. Modellare Apertura finestra
- Disegnare reference planes
- Associare ad essi i parametri necessari
2. Modellare Davanzale finestra
- Creare volume estruso e ancorarlo ai reference planes
- Associare ad esso i parametri necessari
3. Modellare Telaio finestra
- Creare volume estruso (in alzato) e ancorarlo ai reference
planes
- Associare ad esso i parametri necessari
4. Creare una nuova famiglia (window_panel.rfa) per un infisso tipo
5. Inserire la Nested Family (window_panel.rfa)
6. Organizzare parametri per creare una serie di infissi

7. Creare parametri per materiali

8. Impostare Livello Dettaglio e Visibilita

(9
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7. MODELLAZIONE PARAMETRICA

FAMIGLIA DI FINESTRA PARAMETRICA

w_fra me =3

/-SAPIENS

EQ

|
|

w_frame =3 ®
i :
== —Ex
tI
=
B 3
‘|T n
z g
o
B E
= £
T &
@
A - e
J—— = = = + H = g?z
® T [ =
s Il | | =
Il
2 |
: ! [
ﬁI
| f
: 0 . I
Placement Side b L_window = 150 o
Y, | L |
|| | I °
(RS-
T [———_——— I i 3
________ E 4 I F = EI_*_E_*_’
|
[ | I =
I I_tot_window = 150 [l
1 1

Parameter Value Formula | Lock I
m_frame <By Category> |-
m_glass <By Category>
m_sill <By Category>
m_window <By Category>

n_windows

H_window (report) 150.00
L_window (report) 150.00
d_frame 5.00 d_window O
d_glass 0.50 =
d_window 5.00 O
h_sill 90.00 O
h_tot_window 150.00 = O
h_window 141.00 h_tot_window - (2 * w_frame) - th_sill |
|_tot_window 150.00 = O
|_window 72.00 (I_tot_window - (2 * w_frame)) / n_windows O
step_sill 10.00 O
th_sill 3.00 O
w_frame 3.00 O
w_window 5.00 O
5]

Keynote

Model

Manufacturer

Type Comments

Type Image

URL

Description

Assembly Code

Cost

<
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7. MODELLAZIONE PARAMETRICA

FAMIGLIA DI FINESTRA PARAMETRICA

Livelli di Dettaglio e Controllo Visibilita

Quando inseriamo le famiglie 3D in un progetto, si puo ricorrere
ad una visualizzazione 2D delle famiglie, che permette una
gestione migliore del modello da parte di Revit, oltre a contribuire
a ridurre la dimensione totale del modello. Per fare cio € pero
necessario creare dei disegni 2D nella famiglia, che all'occorrenza
saranno utilizzati da revit per la visualizzazione semplificata della
stessa.

Procedimento
- Selezionare I'elemento che si vuole modificare

Propieta > Graphics > Visibility/Graphics Overrides

»

Graphics
Ve [E— S
Visibility/Graphics Ove... Edit...

Oppure
Modify > Visibility Settings
fpols | Modify | Generic Models

& &

Edit ||Visibility| Load into Loz
Family || Settings|| Project Project

|_Mode | Visibil? - ]
Visibility Settings

/-SAPIENS

Family Element Visibility Settings
View Specific Display
Display in 3D views and:
Plan/RCP
Front/Back
[MLeftRight

Detail Levels
Coarse Medium

e =

Fine

Default

Help

In quale tipo di vista (pianta, alzato, 3D) si vuole

visualizzare;

Con quale livello di dettaglio si vuole visualizzare.

Dalla finestra su indicata, € possibile impostare per
I'elemento selezionato:

(9
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7. MODELLAZIONE PARAMETRICA

In Revit esistono due tipologie di famiglie di
annotazione:

1. GENERICHE (simboli, frecce)
2. DI MODELLO (tags, dimensions)

Si tratta sempre di elementi 2D, quindi
visibili sono nella vista in cui sono creati!!

Le annotazioni generiche possono essere:

- caricate come delle normali famiglie di
revit

- create come nuove utilizzando i vari
template caricabili

- modificando quelle di default.

Il template Metric Generic Annotation.rft
ci consente di creare qualsiasi simbolo di
annotazione a partire da una intersezione
tra reference plan.

/-SAPIENS

Look in:

sl

CREARE FAMIGLIE DI ANNOTAZIONE - GENERICHE

Annotations
Nome Ultima modifica Tipo

ka3 Metric Callout Head.rft EM&tric Telephone Device Tag.rft

Metric Data Device Tag.rft @ Metric View Title.rft
Metric Door Tag.rft QMetric Window Tag.rft

Metric Electrical Device Tag.rft
Metric Electrical Equipment Tag.rft
Metric Elevation Mark Body.rft
Metric Elevation Mark Pointer.rft
Metric Fire Alarm Device Tag.rft
Metric Generic Annotation.rft
Metric Generic Tag.rft

lz3 Metric Grid Head.rft

Metric Level Head.rft

Metric Multi-Category Tag.rft
Metric Room Tag.rft

Metric Section Head.rft
Metric Spot Elevation Symbol.rft

v ¢ B ¥ E] vews ~

Preview

»

___+=___

File name: | Metric Generic Annotation.rft

Files of type: |Family Template Files (*.rft)

Cancel

Architecture  Structure  Systems Insert  Annotate  Analyz
@ e N
(53 .» Creates a Revit file. 7
t
New » @ Project h
Creates a Revit project file.
E——‘/ Open » D Family L
Creates a set of custom components
to use in projects,
E Sae Conceptual Mass
@ Opens a template for creating a
conceptual massing model.
g Save As »
Title Block
= Opens a template for creating a Title
A Block family.
=p Export »
Annotation Symbol
l<> Creates a tag or symbol to identify
: C—— elements in the project.
Suite
2 Workflow »
H
% Publish »
Close
[ ] | = =)
| Sesiant] ) ok Rent
(9
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7. MODELLAZIONE PARAMETRICA

CREARE FAMIGLIE DI ANNOTAZIONE - WORKFLOW

Famiglie di Annotazione
(etichette locali, simboli di viste)

WORKFLOW

New Family > Metric Generic Annotation.rft
Disegnamo il simbolo

Aggiungere eventuale testo

Aggiungere eventuale stile di Line e di Hatch
Salvare la famiglia e caricarla in progetto

(9
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7. MODELLAZIONE PARAMETRICA

CREARE FAMIGLIE DI ANNOTAZIONE - di Modello (tags)

Le TAGS sono solitamente delle annotazioni composte da elementi
geometrici e Label (elementi Etichetta) che restituiscono i valori dei
parametri delle famiglie alle quali si riferiscono.
e@m
Le annotazioni di modello possono essere:
- caricate come delle normali famiglie di revit 1 >
- create come nuove utilizzando i vari template caricabili 10

- modificando (duplicando e salvandone una copia) quelle di
default.

In qualsiasi caso, possiamo utilizzare template specifici riferiti ad
alcune categorie di elementi oppure utilizzare il template Generic
Annotation.rft e in sequito associarlo ad una categoria (Type
Property)

(9
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7. MODELLAZIONE PARAMETRICA

ANNOTAZIONI DI MODELLO -

WORKFLOW
* New Family > Door Tag.rfa oppure Metric Door Tag.rfa

* Disegnamo l'etichetta: Label

* In Edit Label menu, selezionare Width > Add ParameterTo Label.

* Ripetere per il parametro Height.

* Aggiungere eventuale Suffisso o prefisso
* Selezionare la Label e click su Edit Type

* Cambiare (o crearne uno) stile di testo

* Salvare la famiglia e caricarlain progetto

NOTA
Attenzione alla riga Background; verificare che sia in Trasparent

/-SAPIENS

Custom Door Tags

—
Properties X
Label i
3mm
Door Tags (1) v Edit Type
Graphics 4
Sample Text XX x XX... Edit Type
Label Edit... Displays pr
Wrap between paramet... :[] element be
Vertical Align Middle
Horizontal Align Center Typg RicE!
family in tl
Keep Readable O the projeci
Visible
e To change
that belon

Type Properties
Family: System Family: Label v Load,.
Type: 3mm v Duplicate. ..
Rename...
Type Parameters
Parameter Value l:

Graphics A
Color Ml Black

Line Weight 1

Background Transparent

Show border L]

Leader/Border Offset 2.0320 mm

Text A
Text Font Arial

Text Size 3.0000 mm

Tab Size 12,7000 mm

Bold O

Italic O

Underline O

Width Factor 1.000000

(9
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7. MODELLAZIONE PARAMETRICA

ANNOTAZIONI DI MODELLO - View Tag

A Queste etichette si riferiscono alle viste di revit (sezione, alzato, pianta e dettaglio).
L3N Anche queste etichette possono essere customizzate o create da zero.
| A101

Tenere in considerazione che I'organizzazione di questi elementi risponde alla seguente gerarchia:

VIEWTYPE ————» CALLOUTTAGTYPE (e/o ELEVATIONTAG, SECTIONTAG) — > HEAD E RADIUS (o TAIL) FAMILY

Type Properties X
Family: System Family: Callout Tag v Load.,
Type: Callout Head w 3mm Corner Radius v Duplicate...
Rename...
Family: System Family: Section v ; Type Parameters
Parameter | Value |:|
Type: Building Section v Duplicate...
|Graphics A
Rename... [ Callout Head {M_Callout Head : M_Callout | i
Type Parameters 8 orner Radius X mm
C Rad 3.0000
Parameter Value |=|
| Graphics A
Callout Tag Callout Head w 3mm Corner Rad Type Properties X
Section Tag Section Head - Filled, Section Tail
Reterence labe! S Family: System Family: Section Tag v Load...
Identity Data 2
View Template applied to new view <None> : Type: Section Head - Filled, Section Tail - Fillec v Duplicate...
New views are dependent on templ
3 Rename...

Type Parameters

Parameter Value l:l
Graphics A
.i. Section Head M_Section Head - Filled
Section Tail M_Section Tail - Filled
Broken Section Display Style Gapped

/-SAPIENS
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7. MODELLAZIONE PARAMETRICA

ANNOTAZIONI DI MODELLO - Custom Section Tag

WORKFLOW

* New Family > Metric Section Head.rfa

* Nel Family Editor NON cambiare la posizione dei piani di riferimento

* Inserire una Label

* In Edit Label menu selezionare Sheet Number > Add Parameter To Label
* Ripetere per il parametro Detail Number

» Disegnare una linea di separazione tra le Labels

* Creare la freccia con il comando Filled Region

* Salvare la famiglia come Section_Arrow.rfa e caricarla in progetto

* Duplicare e rinominare un nuovo tipo di sezione

* Selezionare Section Head e cercare il tipo appena caricato (Section_Arrow)

* In Section Tail selezionare <none>, cosi apparira il simbolo solo ad un estremo!

Type Properties
Family: System Family: Section Tag

Type: Arrow Solid

Type Parameters

Duplicate...

Rename...

Parameter

Value

| Graphics

Section Head

M _Section Head - Filled

Section Tail

M_Section Head - Filled

FB‘r“ol»(en Section Display Style

M_Section Head - No Arrow

M_Section Head - Open
M_Section Tail - Filled

M_Section Tail - Filled Horizontal
Section_Arrow

»

(9
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7. MODELLAZIONE PARAMETRICA

ANNOTAZIONI DI MODELLO - Custom Elevation Tag

Nel caso della Elevation Tag, il procedimento di creazione & molto simile a
quello precedente.

In questo caso bisogna creare prima un Custom Elevation Mark Body e poi un
Custom Elevation Mark Pointer, attraverso i rispettivi template.

WORKFLOW

New Family > Metric Elevation Mark Body.rfa

Inserire una Label

In Edit Label menu selezionare Sheet Number > Add Parameter To Label
Disegnare le linee

Salvare la famiglia come Elev_Body.rfa

New Family > Metric Elevation Mark Pointer.rfa

Inserire una Label

In Edit Label menu selezionare Detail Number > Add Parameter To Label
Disegnare la freccia

Salvare la famiglia come Elev_Pointer.rfa

Caricare questa famiglia all'interno di Elev_Body e inserirla 4 volte vicino
l'intersezione dei reference planes

Caricare in progetto

Duplicare e rinominare un nuovo tipo di sezione e sostituire I' Elevation Tag.

kzz3 Metric Electrical Device Tag.rft
@ Metric Electrical Equipment Tag.rft

Emi Metric Eievation Mark Body.rft

Metric Elevation Mark Pointer.rft

Arteis Civm Alavinn Navsicn Tam £+

Type Properties

Family: System Family: Elevation

Type: Building Elevation 2

Type Parameters

~ Duplicate...

Rename...

Parameter

Value

| Graphics

Elevation Tag

12.5mm Square

Callout Tag

Callout Head w 3mm Corner Radius

Reference Label

Identity Data

View Template applied to new views

Sim

<None>

New views are dependent on template

(9
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7. MODELLAZIONE PARAMETRICA

FAMIGLIE DI CARTIGLI - Custom Titleblocks

Quando si crea un nuovo elaborato grafico (Sheet), revit rimanda a
possibili formati di fogli default con relativi titleblocks.

Ma come in tutte le famiglie di Revit, anche in questo caso possiamo
customizzare sia il formato dell'elaborato di stampa, sia il Titleblock.

Il Cartiglio di stampa include vari elementi:
- Formato Foglio

- Squadratura e Ripiegatura (eventuale)
- Intestazione

WORKFLOW

- Creare squadratura

- Creareripiegatura A4 (210 x 297 mm)
- Creare intestazione

NOTA

Nell' Intestazione sono presenti sempre:

- Parametri di Progetto > indicizzatitra le Project Information

- Parametri dilstanza > indicizzati tra i Parametri delle Properties

/-SAPIENS

ReBG-&-7-@=2-20A 6-0FH

Architecture  Structure  Systems  Insert  Annotate  Analy:

SIB| creates a Revt fe.

v o Project
Creates a Revit project file,

E Open » O Family
Creates a set of custom components

to use in projects.
E s Conceptual Mass
@ Opens a template for creating a
conceptual massing model,
B o
Title Block
[} Opens a template for creating aTile
Block famiy.
= Bpot b

Annotation Symbol
L} Creates a tag or symbol to identity
== elements in the project.

Suite
2B Workflow  »

“m RoMA | COMUNE DI ROMA
CAPITALE| Municipio PROJ. INFO.
PROJ. INFO.
PROJ. INFO.

COMUNICAZIONE INIZIO LAVORI ASSEVERATA
(CILA)

D.L.222/12018, Tabella A, sez. Il - Edilizia. art 1,¢. 3
D.P.R. n. 3802001, art.3. c.1, lett B e art. bis

Dati Catastali PROJ. INFO.
Richiedente/Proprietario: Progettista:
PROJ. INFO. PROJ. INFO.
Elaborati:

PROPERTIES PROPERTIES

Data PROPERTIES

PROPERTI

ES

(9

Sapiens

CA IL TUO FUTURO



7. MODELLAZIONE PARAMETRICA

FAMIGLIE DI CARTIGLI - Custom Titleblocks

I
WORKFLOW
» 210.000 ¢
Cartiglio - Squadratura e Ripiegatura g 1 .
- New family > Titleblock > Selezionare un formato g COMUNE DI ROMA
K ¢- Select Template File =
- Creare la squadratura parametrica . i e
- Titleblocks
v Nome
Cartiglio - Intestazione Rn
. . A2 metric.rft
- (1) Creo la struttura dell'intestazione secondo lo schema e st
bl A4 metric.rft
parametri indicati EaiNew sizemetict
- Creare i testi fissi: Text category 8
- Inserire Logo nell' apposito spazio: Insert Image :
8
Family Types X h
Type name: ﬁ 1A COMUNICAZIONE INIZIO LAVORI ASSEVERATA
5 ciLa)
Search parameters Ql Y D.L. 222/2016. Tabella A sez. |l - Edilizis, srt. 1, ¢. 3
D.P.R.n.380/2001, art.3, c.1, lett. B e art.8 bis
Parameter Value Formula |Lock| g Coordinate Catastali:
Dimensions 2 ; Richiedente/Proprietario: Progetista
H_paper 594.000 =n_V*297 mm O g 105,061 94.948
squadratura 5.000 = O )
z 0.000 = Elsborati:
W_paper 840.000 =n_H*210 mm O &
v foto_prog (default) __110.000 i 0. 5
Other a ¢
n_H 4 = O
nV 2 = ) D ) E Dats I
é Slﬂﬂlﬂ 150 .000 [ $0.000 5'00'0

(9
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7. MODELLAZIONE PARAMETRICA

FAMIGLIE DI CARTIGLI - Custom Titleblocks

I
WORKFLOW (continua vy
( ) ROMA | COMUNE DI ROMA
AD g : :

- Creare un'altra General Annotation, in cui Edit Shared Parameters x CAPITALE Municlplo PROJ: INFO.

. . . . . PROJ. INFO.

inseriamo una immagine di progetto e Shared porameter fle: PROJ. INFO.

. . . . . | X:\2018\00_LIB_EF_DEFAULT\0 l_SH_PAl Browse... Create...
parametrizziamo una delle due dimensioni
Parameter group:
TitleBlocks v
- Caricare la famiglia in quella del cartiglio parameters: .
. . . . ! Dati Catastali

(questa famiglia contiene una immagine Eaborat 1 Ne...

variabile e quindi puo riutilizzarsi nei vari e s

progetti, caricando I'immagine descrittiva) —

Delete
. i i Groups

- (2) Nell'editor family del titleblock, creare le New...

tags in tutti i campi dell'intestazione

associandoli ai rispettivi parametri: Project

. . COMUNICAZIONE INIZIO LAVORI ASSEVERATA
Name, Project Address, Client Name, Author, (CILA)
Sheet Issue Date, Scale, Sheet Number O R . 3502001, a3 o1, et B e a6 bis
oo g Dati Catastali PROJ. INFO.
=1

- (3) Creare un nuovo gruppo di parametri il Richizdane Propiztario: Progetists

condivisi (es. Titleblocks) per gli altri parametri 2z=bdos N PROJ. INFO. PROJ. INFO.

non esistenti: Municipio, Dati Catastali, | o

Elaborati e Elaborati 1 PROPERTIES PROPERTIES
- Creare un gruppo e delle quote parametrizzate

Data PROPERTIES PROPERTIES

con cui ancorarlo alla squadratura

/-SAPIENS
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7. MODELLAZIONE PARAMETRICA

WORKFLOW (continua)

Parametrizzare la dimensione del foglio, in
modo che sia basata su multipli del formato Az
(simulazione della ripiegatura)

Salvare e caricare in un progetto per verificare
il funzionamento della famiglia

PROPRIETA DELLA FAMIGLIA

/-SAPIENS

Creare vari tipi corrispondenti ai formati di
fogli multipli dell' A4

Inserire parametri di Progetto

Inserire parametri di Istanza

FAMIGLIE DI CARTIGLI - Custom Titleblocks

Properties

b
@ Sheet

Sheet: PROPERTIES
Graphics

Visibility/Graphics Overr...

+ | 3 Edit Type

A

Edit...

Scale

Identity Data

>»

Independent

Referencing Sheet

Referencing Detail

Current Revi sued

Current Revi

' Project Information X
Family: System Family: Project Information
Type:
Instance Parameters - Control selected or to-be-created instance
Parameter Value |

Identity Data A
Organization Name [
Organization Description

Building Name

Author PROJ. INFO.

Municipio PROJ. INFO.

Dati Catastali PROJ. INFO.

Energy Analysis A
Energy Settings Edit...

Other A
Project Issue Date PROJ. INFO.

Project Status

Client Name PROJ. INFO.

Project Address PROJ. INFO.

Project Name PROJ. INFO.

Project Number

Current Revision

Approved By Approver

Designed By Designer

Checked By Checker

Drawn By Author

Sheet Number PROPERTIES

Sheet Name PROPERTIES

Sheet Issue Date PROPERTIES

Elaborati PROPERTIES

Elaborati 1 PROPERTIES

Appears In Sheet List

Revisions on Sheet Edit...
Other A

File Path :

Guide Grid <None>

Cancel
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/-SAPIENS

7. MODELLAZIONE PARAMETRICA

FAMIGLIE DI CARTIGLI - Custom Titleblocks

B ROMA
CAPITALE

COMUNE DI ROMA
Municipio PROJ. INFO.

FROJ. INFO,

FROJ. INFO.

INIZIO LAVORI
(ciLay
PROJ. INFO.
[ — p—
PROJ. INFO. PROJ. INFO.
PROPERTIES FROPERTIER

e PROPCETEZ

| | PROFCATES

(9
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